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1. UVOD 

 

Prirodni radionuklidi prisutni su na Zemlji u značajnim količinama. Oni uključuju 

primordijalne radionuklide, poput 40Kalija, 235Uranija, 238Uranija i 232Torija, te izotope nastale 

njihovim poluraspadom (IAEA, 2022). Kada se sirovine s niskim koncentracijama radionuklida 

koriste u industrijskim procesima, kao što je sagorijevanje prirodnog ugljena u termoelektrani, 

koncentracija radionuklida se u nastalim nusproizvodima, poput pepela i šljake, može 

višestruko povećati. U radu se kartiraju povišene koncentracije prirodnih radionuklida na 

području bivše tvornice Jugovinil u Kaštelanskom zaljevu. U sklopu tvornice je u pogonu bila 

termoelektrana na ugljen. Njenim dugogodišnjim radom proizvedena je velika količina otpada 

(pepela i šljake) koji su sadržavali povišene količine radionuklida. Otpad je odlagan u blizini 

tvornice te se područje nije u potpunosti saniralo. Upotreba GIS softvera učinkovita je pri 

analizi raspodjela koncentracija onečišćivala jer je podatke moguće geostatistički obraditi i 

jasno predočiti. Za interpolaciju koncentracija radionuklida preko cijelog područja istraživanja 

korištena je metoda Empirical Bayesian Kriging. 
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2. PRIRODNI RADIONUKLIDI 

 

Prirodni radionuklidi definirani su prema IAEA (International Atomic Energy Agency) kao 

radionuklidi koji se prirodno nalaze na Zemlji u značajnim količinama. Pojam se obično koristi 

za primordijalne radionuklide (40K, 235U, 238U, 232Th) i radionuklide koji su proizvodi njihovog 

raspada.  U okolišu je prisutno više od 60 prirodnih radionuklida. Prema podrijetlu oni se dijele 

u dvije skupine: primordijalne i kozmogene. Primordijalni radionuklidi prisutni su u zemljinoj 

kori od njenog nastanka i nalaze se u stijenama i mineralima. Ova skupina uključuje tri 

dugovječna aktinidna nuklida (232Th, 235U i 238U). Raspad navedenih radionuklida ponovno 

stvara radionuklide kćeri, stvarajući nizove koji konačno završavaju u stabilnim izotopima 

olova (slika 2-1). Unutar ovih nizova radionuklida može se uočiti α-, β- i γ-zračenje. Za razliku 

od takvih nizova, niz kalija-40 se raspada tvoreći stabilne izotope 40Ca i 40Ar. Kozmogeni 

radionuklidi kontinuirano se proizvode u atmosferi bombardiranjem kozmičkim zrakama 

elemenata poput dušika, kisika i argona. Ovi radionuklidi dospijevaju na Zemljinu površinu 

putem oborina, suhih padalina ili kroz plinovite geokemijske procese. Tipični predstavnici su 

radiokarbon (14C), tricij (3H), te izotopi natrija (22Na) i berilija (7Be). 

 

Slika 2-1. Uranijski, torijski i aktinijski niz nuklearnog raspada (Ojovan i Lee, 2005). 
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Prirodni radionuklidi prisutni su u Zemljinoj kori, ali njihova distribucija nije ravnomjerna. 

Kada se sirovine koje sadrže relativno niske koncentracije prirodnih radionuklida uvedu u 

industrijski proces, tada se radionuklidi mogu koncentrirati u dobivenim nusproizvodima. 

(Kovacs et al., 2017). Takve aktivnosti uključuju rudarenje i preradu ruda, proizvodnju 

prirodnog plina i nafte, izgaranje fosilnih goriva i proizvodnju ugljenog pepela izgaranjem 

ugljena u elektranama (Francis i Nancharaiah, 2015). Materijal koji ostaje nakon industrijskog 

procesa, u čijem su sastavu ili koji je onečišćen prirodnim radionuklidima, je u Pravilniku o 

praćenju stanja radioaktivnosti u okolišu definiran kao rezidui. 
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3. GIS I INTERPOLACIJA PODATAKA 

 

GIS (Geografski informacijski sustav) softver se često koristi u upravljanju i monitoringu 

onečišćenja jer je korištenjem softvera moguće analizirati i kartirati različite vrste prikupljenih 

podataka. U softveru je moguće kombiniranje različitih izvora podataka poput mjerenja 

kvalitete zraka, vode ili tla, satelitskih snimaka, georeferenciranih topografskih karata i sl. Karte 

izrađene u GIS-u korisne su pri identificiranju žarišta onečišćenja, praćenju promjena 

izmjerenih koncentracija u vremenu i modeliranju širenja utjecaja zagađivača. To omogućuje 

bolju procjenu rizika, ciljane intervencije i informirano donošenje odluka. Osim toga, GIS 

olakšava učinkovitu komunikaciju s javnošću kroz jasne vizualizacije temeljene na podacima.  

Empirical Bayesian Kriging (EBK) je geostatistička metoda interpolacije koja se koristi u GIS 

softveru za procjenu vrijednosti na lokacijama gdje podaci nisu prikupljeni, na temelju poznatih 

podatkovnih točaka. Za razliku od običnog kriginga, uključuje dodatne informacije o prostornoj 

varijabilnosti iz cijelog skupa podataka, a ne samo iz susjednih točaka. Skup podataka dijeli se 

u podskupove kako bi se bolje razumjela prostorna varijabilnost unutar svakog podskupa što je 

posebno važno u složenim skupovima podataka gdje prostorni uzorci nisu ujednačeni. Zatim se 

procjenjuju parametri variograma. Variogram opisuje koliko su podaci povezani na različitim 

udaljenostima, zasebno za svaki podskup. Zasebnom obradom svakog podskupa točnije se 

obuhvaćaju specifične karakteristike svakog od njih. Takvom metodom moguće je fleksibilnije 

i prilagodljivije modelirati prostorne varijabilnosti u usporedbi s jednostavnim krigingom, koji 

može pretpostaviti samo jedan variogram za cijeli skup podataka (ESRI, 2024). EBK je posebno 

koristan u studijama o okolišu, kao što je kartiranje razina onečišćenja ili predviđanje 

kontaminacije tla, gdje je za analizu i mogućnosti sanacije, ključna preciznost. 
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4. PODRUČJE ISTRAŽIVANJA 

 

Područje istraživanja nalazi se u sklopu bivše tvornice Jugovinil u Kaštelanskom zaljevu, 

između Kaštel Gomilice i Kaštel Sućurca. Područje pripada srednjem Jadranu i radi se o 

poluzatvorenom, niskoenergetskom okolišu ukupne površine 60 km², prosječne dubine 23 

metra. Do ranih 1990-ih okolno područje bilo je gusto naseljeno i odlikovalo se najvećom 

razinom industrijalizacije duž istočne obale Jadrana. Kao posljedica intenzivne industrije 

pojavili su se mnogi izvori onečišćenja kao što su bivša kemijska tvornica Jugovinil, tvornica 

cementa, tvornica željeza, brodogradilište i postrojenje za galvanizaciju. Povrh toga, 

onečišćenju zaljeva pridonio je gust promet na glavnoj cesti u blizini obale (Lovrencic et al., 

2005).  

U sklopu tvornice, od 1941. godine, u pogonu je bila termoelektrana za čiji se rad koristio 

ugljen. Postojalo je više izvorišta sagorijevanog ugljena neka od kojih su Raša u Istri (antracit), 

Drinovci i Širitovci kod Šibenika (mrki ugljen i lignit) te šire područje Livanjskog polja u Bosni 

i Hercegovini (mrki ugljen i lignit). Sav ugljen bio je izvor povišenih koncentracija uranija i 

drugih prirodnih radionuklida nastalih njegovim poluraspadom. Šljaka i pepeo, nastali radom 

termoelektrane, sadržavali povišene koncentracije prirodnih radionuklida, koja se procesom 

izgaranja višestruko povećala. Šljaka i pepeo odlagani su u blizini tvornice do 1973. godine, a 

zatim su premješteni na prikladniju lokaciju nekoliko stotina metara dalje, na rubu mjesta Kaštel 

Gomilica, gdje su prekriveni zaštitnom plastičnom folijom i slojem gline i humusa. Prostor je 

potom ograđen i prekriven travom. S vremenom je prostor između tvornice i starog skladišta 

postupno bio prekriven novim otpadnim materijalima koji su sadržavali trosku i pepeo 

(Oreščanin et al., 2005).  

Za potrebe rada područje je podijeljeno na 7 zona, ovisno o svojedobnoj uporabi prostora (slika 

4-1). Zona A – lokacija stare deponije rudne jalovine s povećanom prirodnom radioaktivnošću, 

sanirano 1973. uključujući materijal iskopan iz zone C, zona B – područje zatrpano pepelom 

kao i građevinskim otpadom i otpadom od rušenja tijekom 1970-ih i 1980-ih, zona Bn – 

servisno područje mola zatrpano 1990-ih, zona Bmt – područje očišćeno tijekom sanacije 1973. 

godine, zona Cug – odlagalište ugljena u funkciji od 1949. godine i zona D – područja s 

vjerojatnom akumulacijom pepela, bivša taložnica od posebnog interesa za istraživanje jer se 

na toj lokaciji skladištio pepeo i šljaka dobiveni iz ugljena korištenog u termoelektrani (Prlić et 

al., 2011; IMI i FZOEU, 2011). 
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Slika 4-1 Podjela područja istraživanja na istražne zone  



7 

 

5. OBRADA PODATAKA I PRIMJENA GIS TEHNOLOGIJE 

 

Za grafički prikaz mjerenih koncentracija prirodnih radionuklida korišteni su računalni softveri 

ArcMap 10.8.2 i ArcGIS Pro 3.2.0., ovaj potonji je moderniji GIS softver koji je ESRI razvio 

kao zamjenu za ArcMap (ArcGIS Desktop) generaciju softvera.   

Ulazni podaci za rad u softveru su koncentracije radionuklida mjerene i zabilježene u obliku 

Microsoft Excel tablice. Mjerenja su izvođena na području odlagališta pepela i šljake 

termoelektrane Jugovinil u Kaštelima, na stalnim i obilježenim lokacijama (Tablica 5-1). 

Točkama mjerenja su u Excel tablici pridružene koordinate, opis lokacije i naziv točke. Od 

podataka dobivenih u tablici korišteni su oni koji se odnose na prirodne radionuklide, budući 

da ista sadržava mjerenja i za mnoge druge elemente.  

Kako bi se podaci mogli obrađivati u GIS-u, potrebno ih je pretvoriti u odgovarajući format. 

Dobivena tablica svedena je na novu, koja sadrži samo podatke koji su relevantni za rad i u 

obliku koji odgovara GIS obradi. Nova tablica prikazana je u tablici 5.1. 

Tablica 5-1. Formatirani tablični podaci. 

 

 

 

 

 

Mjesto Oznaka Sirina Duzina NmV DatumOpis lokacije
Istazne

_zone
Ra226 Pb214 Bi214 Ac228 Bi212 Tl208 K40 Cs137 I131 Be7

Marina kastelaIG1 5613981.35 4823167.077 1.90 1.3.2010. marina rt Bnm 19.58 33.58 31.42 22.81 10.25 27.22 96.89 100.48 88.93 153.16

Marina kastelaIG2 5614025.517 4823184.49 2.06 1.3.2010. marina rt Bnm 19.17 29.34 43.19 17.93 -6.60 18.77 26.20 96.68 78.30 133.66

Marina kastelaIG3 5614079.61 4823174.30 1.95 1.3.2010. marina rt Bnm 20.44 19.90 36.19 28.77 11.36 48.19 133.97 116.02 74.94 115.34

Jugovinil IG4 5614181.62 4823198.25 3.39 1.3.2010.brodogradilisteBmt 19.35 23.45 27.17 15.29 6.60 23.15 93.92 8.80 64.68 103.00

Jugovinil IG5 5614184.75 4823327.99 4.27 1.3.2010.plato kod kugli B 285.46 587.74 860.88 29.66 32.40 38.80 74.64 378.51 261.79 391.02

Jugovinil IG6 5614172.07 4823361.11 3.63 1.3.2010.plato kod kugli B 295.14 632.48 895.81 59.08 29.69 40.05 87.00 237.67 280.08 423.88

Jugovinil IG7 5614225.19 4823326.79 3.53 1.3.2010.plato kod kugli B 95.15 183.45 331.03 25.94 27.11 16.90 49.93 434.25 225.32 323.37

Jugovinil IG8 5614236.90 4823275.09 3.56 1.3.2010.plato kod kugli B 81.89 172.20 111.09 9.68 21.47 48.81 61.79 340.36 174.11 245.05

Jugovinil IG9 5614222.34 4823256.40 5.58 1.3.2010.mala taloznicaBmt 229.25 544.22 782.70 69.65 12.83 102.63 134.46 123.23 257.60 392.96

Jugovinil IG10 5614194.33 4823239.81 3.68 1.3.2010.mala taloznicaBmt 87.79 240.31 389.35 31.99 12.83 73.22 81.57 173.11 209.65 297.33

Jugovinil IG11 5614210.02 4823249.18 4.12 1.3.2010.mala taloznicaBmt 146.73 434.40 612.17 33.39 31.40 108.89 68.22 -240.60 236.25 336.14

Jugovinil IG12 5614179.19 4823231.88 4.15 1.3.2010.mala taloznicaBmt 120.63 301.49 460.33 45.51 2.57 42.55 115.18 132.04 217.82 280.73

Jugovinil IG13 5614154.73 4823277.70 3.87 1.3.2010.brodogradilisteBmt 98.10 223.61 338.80 11.39 5.13 26.28 70.69 171.32 178.49 192.14

Jugovinil IG14 5614166.23 4823390.58 3.75 1.3.2010.pokraj stare deponije - sjeverno od servisne cesteB 276.62 623.05 922.43 27.97 35.87 45.68 81.57 129.10 284.35 206.06

Jugovinil IG15 5614225.37 4823397.13 3.53 1.3.2010.sjeverno od servisne ceste - ravnina kugliB 25.68 78.14 119.62 48.37 16.99 20.65 104.80 296.35 124.85 66.83

Jugovinil IG16 5614495.30 4823366.60 1.47 2.3.2010.Skladište ugljenaCug 225.88 377.55 530.64 42.63 24.03 23.87 69.21 268.98 198.84 260.50

Jugovinil IG17 5614935.32 4823240.74 3.50 2.3.2010. taloznica D 86.94 162.34 229.75 29.82 15.37 14.87 68.22 174.03 133.50 116.96

Jugovinil IG18 5614931.20 4823325.79 3.48 2.3.2010. taloznica D 28.07 36.17 59.57 23.95 10.63 17.98 107.77 133.27 96.05 178.22

Jugovinil IG19 5614856.77 4823263.41 3.54 2.3.2010. taloznica D 846.28 575.20 812.28 49.69 36.07 69.46 110.24 29.34 283.54 411.99

Jugovinil IG20 5614793.33 4823271.66 4.01 2.3.2010. taloznica D 254.09 591.64 909.45 90.73 36.95 46.31 139.40 302.67 285.05 353.65

Jugovinil IG21 5614645.56 4823248.70 4.33 2.3.2010. taloznica D 269.25 590.17 842.03 59.96 35.13 48.19 89.48 268.29 258.04 379.22

Jugovinil IG22 5614645.34 4823261.69 4.48 2.3.2010. taloznica D 257.46 771.97 1089.00 40.98 39.58 46.93 102.33 260.87 301.18 373.14

Jugovinil IG23 5614596.01 4823229.40 3.93 2.3.2010. taloznica D 206.10 510.47 740.18 61.94 22.36 26.28 111.23 325.58 253.67 368.86

Jugovinil IG24 5614619.07 4823218.68 3.95 2.3.2010. taloznica D 168.83 454.22 588.95 35.81 26.13 18.77 60.80 161.20 188.94 280.42

Jugovinil IG25 5614707.90 4823223.86 4.25 2.3.2010. taloznica D 167.78 373.74 513.16 49.58 23.79 28.79 139.90 184.46 194.91 268.77

Jugovinil IG26 5614807.59 4823227.45 4.17 2.3.2010. taloznica D 226.73 539.20 617.02 64.51 23.48 20.65 76.62 210.94 190.90 245.05

Jugovinil IG29 5614310.51 4823224.55 3.51 3.3.2010.kod pontona - bazenC 43.16 114.83 144.60 13.84 12.08 15.15 76.62 243.53 114.80 153.16

Jugovinil IG30 5614285.04 4823296.35 3.68 3.3.2010.plato kod kugli B 2.74 45.08 94.86 36.20 16.20 22.02 172.03 158.44 116.78 239.48

Jugovinil IG31 5614301.83 4823335.53 3.69 3.3.2010.plato kod kugli B 55.58 120.37 175.07 22.31 18.16 15.43 107.27 246.47 129.13 105.82

Jugovinil IG32 5614416.90 4823209.20 3.60 3.3.2010.brodogradiliste C 27.71 66.72 93.77 13.97 13.12 10.64 74.15 140.84 97.24 144.80

Jugovinil IG33 5614578.37 4823217.72 3.65 3.3.2010.plato zapadno od talozniceC 50.52 176.27 253.62 27.98 14.66 18.77 86.51 149.64 151.21 221.74

Jugovinil IG34 5614541.83 4823273.49 3.62 3.3.2010.plato zapadno od talozniceC 103.15 217.46 294.22 33.70 20.52 18.15 109.74 58.68 157.52 213.62

Jugovinil IG35 5614526.35 4823285.56 3.75 3.3.2010.plato zapadno od talozniceC 10.53 47.42 88.46 17.92 10.94 9.39 84.53 70.42 97.24 149.65
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5.1 ArcMap 

 

Prvi dio GIS obrade odrađen je u softveru ArcMap 10.8.2. Prvi korak bio je georeferenciranje 

satelitskog snimka područja istraživanja. Dobivena tif datoteka dodaje se u softver te se pomoću 

Georeferencing alata smješta na odgovarajuću lokaciju u odabranom koordinatnom sustavu - 

HTRS96/TM. U softver se kao dodatna podloga, a i svojevrsna provjera provedenog 

georeferenciranja, dodaje i podloga Geoportala Digitalni ortofoto 2020 – WMS. Pomoću 

georeferencirane karte i podloge, područje istraživanja podijeljeno je na sedam zona, ovisno o 

svojedobnoj upotrebi područja. Za prikaz podjele poligoni su iscrtani korištenjem alatne trake 

Editor i Create features prozora (Slika 5-1).   

 

 

Slika 5-1. Crtanje poligona zona područja istraživanja. 

Idući korak je unos Excel podataka u softver, podaci se dodaju klikom na File > Add XY Data 

naredbe (Slika 5-2). Klikom se otvara izbornik u kojemu se odabire list iz obrađene Excel 

tablice te se odabiru stupci tablice koji predstavljaju X i Y polja, gdje se za X polje odabire 

stupac Sirina, a za Y polje stupac pod nazivom Duzina. Sirina i Duzina odnose na koordinate 

točaka mjerenja, te će točno smjestiti točke na georeferenciranu kartu (slika 5-3). 
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Slika 5-2. Unos tabličnih podataka u ArcMap. 

 

Slika 5-3. Unos tabličnih podataka u ArcMap 
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Za daljnju obradu potrebno je podatke unesene u softver izvesti u Shapefile datoteku na način 

da se u tablici sadržaja, gdje su isti podaci sada dodani, tablica odabere desnim klikom te se 

odabere opcija Data > Export data (slika 5-4).  

 

Slika 5-4. Eksportiranje tabličnih podataka u Shapefile. 

Tada se u izborniku odabire koordinatni sustav novonastalog Shapefile -a, naziv te mapa u koju 

će se isti spremiti. Za koordinatni sustav bira se onaj u kojemu je i sam projekt (slika 5-5). 

 

  

Slika 5-5. Spremanje novog Shapefile-a. 

Nakon što su spremljeni, Shapefile-ovi se dodaju u tablicu sadržaja. Kada im se uključi 

vidljivost, na karti se pojavljuju točke mjerenja koncentracija, koje su označene žutim 

kružićem. U svrhu preglednosti podataka točke mjerenja su labelirane. Desnim klikom na 
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Shapefile odabire se Properties > Labels. U Label Field rubrici odabire se stupac tablice 

Oznaka, kako bi labele točaka odražavale njihove oznake u Excel tablici (slika 5-6).  

 

 

Slika 5-6. Labeliranje točaka mjerenja. 

Krajnji rezultat rada u softveru ArcMap prikazan je na slici 5-7. Završena karta spremna je za 

daljnju obradu u softveru ArcGis Pro, u kojemu će biti izvršena interpolacija mjerenih 

vrijednosti koncentracija prirodnih radionuklida. 

  

 

Slika 5-7. Završna karta u ArcMap-u. 
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5.2 ArcGIS Pro 

 

Nastavak obrade podataka tj. izrada karte interpolacije, odvija se u softveru ArcGIS Pro 3.2.0. 

Karte su izrađene na baznoj karti prikazanom na slici 7., koju se importiralo u softver klikom 

na  Insert > Import map, te odabirom odgovarajuće .mxd datoteke.   

Postupak interpolacije provodi se klikom na Analysis > Geostatistical Wizard. Otvara se prozor 

sa slike 5-8. u kojemu se odabire metoda interpolacije (Empirical Bayesian Kriging) i podaci 

koji se obrađuju (Desetorka). Na slici 5-9. prikazane su postavke interpolacije koje su iste za 

svaki od deset elemenata. 

 

Slika 5-8. Geostatistical wizard - odabir metode i podataka. 

 

Slika 5-9. Postavke kriginga. 
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Dobivena karta je po vrsti shapefile-a točka, te se za daljnju obradu mora eksportirati u raster. 

Na slici 5-10. prikazan je postupak.   

 

Slika 5-10. Eksportiranje interpolirane karte u raster. 

U Geoprocessing prozoru koji se otvori potrebno je odrediti mapu u koju će se novonastali 

raster pohraniti i njegov naziv. Nakon eksportiranja raster je automatski dodan u prozor 

sadržaja. Zadnji korak u uređivanju karte pojedinog elementa je rezanje rastera prema obliku 

poligona područja istraživanja, napravljenog u ArcMap-u. Klikom na Analysis > Tools otvara 

se Geoprocessing prozor u kojemu se pomoću trake pretraživanja odabire alat Clip Raster. 

Klikom na alat otvara se prozor u kojemu se odabiru postavke oblikovanja rastera (slika 5-11). 

Odabire se raster i poligon prema kojemu se raster oblikuje – Output Extent. Potrebno je 

označiti rubriku Use Input Features for Clipping Geometry. 
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Slika 5-11. Postavke oblikovanja pojedinog rastera. 

 

Deset karata, dobivenih za pojedine elemente, potrebno je normalizirati u svrhu boljeg 

uspoređivanja i konačno njihovog zbrajanja. Klikom na Analysis > Tools > Standardize Field 

otvara se alat za standardizaciju, pri čemu je odabrana metoda Minimum-maximum. U rubrici 

Input Table odabire se sloj Desetorka, maksimalna vrijednost je 1, a minimalna 0 (slika 5-12). 
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U atributnoj tablici Desetorke tada će se dodati stupci STAND 1-10, čije su vrijednosti 

standardizirane vrijednosti pripadajućeg stupca koncentracije pojedinog elementa.  

 

Slika 5-12. Standardizacija rastera Standardize Field alatom. 

Novonastale standardizirane vrijednosti koriste se za izradu novih interpoliranih karata, istim 

postupkom kao i za izvorne vrijednosti (slike 5-8. – 5-11). Zadnji korak u obradi podataka 

predstavlja zbrajanje svih 10 interpolacijskih karata normaliziranih vrijednosti. Zbrajanje se 

radi klikom na Analysis > Tools > Raster Calculator. Odabiru se željeni rasteri i odgovarajući 

operator (+), te se odabire mapa za pohranjivanje i naziv izlaznog, zbrojenog rastera (Slika 5-

13). 
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Slika 5-13. Zbrajanje rastera Raster Calculator alatom. 

Završna karta dobivena svim dosad opisanim postupcima prikazana je na slici 5-14. 

 

Slika 5-14. Karta zbroja koncentracija svih elemenata. 
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6. REZULTATI I RASPRAVA 

 

Na idućim slikama prikazane su interpolacijske karte koncentracije deset elemenata 

uzorkovanih na području istraživanja. Na slikama se uočava raspodjela koncentracija u okviru 

promjene boje na karti, gdje crvene do žute boje označavaju višu koncentraciju, a plava boja 

označava nižu koncentraciju danog elementa. Vrijednosti su na svakoj karti i brojčano 

prikazane na priloženoj legendi. 
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Slika 6-1. Interpolacijska karta koncentracije radija-226. 
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Slika 6-2. Interpolacijska karta koncentracije olova-214. 
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Slika 6-3. Interpolacijska karta koncentracije bizmuta-214. 
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226Radij je član uranijskog radioaktivnog niza (slika 2-1). Peti po redu radionuklid u nizu, 

nastaje raspadom 230Torija i s vlastitim vremenom poluraspada od 1600 godina prelazi u 

222Radon, prilikom čega emitira alfa zračenje. 226Radij je prirodno prisutan u svim stijenama i 

tlima u različitim količinama (Paschoa i Steinhäusler, 2010).  

214Olovo je osmi član uranijskog niza, nastaje raspadom 218Polonija te s relativno kratkim 

vremenom poluraspada od 27 minuta, prelazi u 214Bizmut koji nakon 19.7 minuta prelazi u 

214Polonij. Svojim poluraspadom 214Olovo i 214Bizmut oslobađaju beta zračenje (slika 2-1). Za 

sve susjedne radionuklide koji su članovi istog radioaktivnog niza, kao što su u ovom slučaju 

214Olovo i 214Bizmut, može se očekivati negativna korelacija (tablica 6-2). Zbog prirode 

radioaktivnog raspada, količina 214Bizmuta, prisutna u danom trenutku, točno je određena 

postojećom  količinom 214Olova koje se može u njega raspasti. To stvara inverzni odnos količine 

susjednih izotopa u radioaktivnom nizu. Kako se količina 214Olova smanjuje njegovim 

poluraspadom, povećava se količina 214Bizmuta jer je proizvod tog raspada. Unatoč opisanom 

odnosu, na interpolacijskim kartama moguće je opaziti da su povišene koncentracije oba 

izotopa rasprostranjene su na isti način (slike 6-2. i 6-3). Sličnu raspodjelu koncentracije može 

se zapaziti i na karti koncentracije 226Radija, s devijacijom u zapadnom kraju područja zone D 

(slika 6-1). Uzrok iste raspodjele je to što sva tri izotopa dijele isti izvor: pepeo ugljena povišene 

koncentracije uranija, čijim su poluraspadom nastali.  

 

 

 

 

 

 

 

 

 



22 

 

 

Slika 6-4. Interpolacijska karta koncentracije aktinija-228. 
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Slika 6-5. Interpolacijska karta koncentracije bizmuta-212. 
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Slika 6-6. Interpolacijska karta koncentracije talija-208. 
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228Aktinij je član torijskog niza. Kao treći član nastaje raspadom 228Radija, te ima vrijeme 

poluraspada od 6 sati, nakon čega se raspada u 228Torij prilikom čega se emitira beta zračenje 

(slika 2-1). Aktinij se u prirodi nalazi kao element u tragovima u rudama uranija i torija – u rudi 

koja sadrži uranij biti će prisutan izotop 227Aktinija, dok se 228Aktinij pronalazi u rudama torija, 

koje po jednoj toni torija sadrže oko pet nanograma 228Aktinija.  

212Bizmut je deveti član torijskog niza, nastaje beta raspadom 212Olova. 212Bizmut ima vrijeme 

poluraspada od 60 minuta, nakon kojih prelazi u 208Talij i oslobađa alfa zračenje (slika 2-1).  

Povišene koncentracije navedenih izotopa opažaju se u zonama A, Bmt i D. Zona A – lokacija 

stare deponije rudne jalovine, Bmt – područje očišćeno tijekom sanacije 1973. godine i D – 

područja s vjerojatnom akumulacijom pepela, bivša taložnica od posebnog interesa za 

istraživanje jer se na toj lokaciji skladištio pepeo i šljaka dobiveni iz ugljena korištenog u 

termoelektrani (slike 6-4., 6-5. i 6-6).  
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Slika 6-7. Interpolacijska karta koncentracije cezija-137. 
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Slika 6-8. Interpolacijska karta koncentracije joda-131. 
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Prirodna proizvodnja 137Cs spontanom fisijom ne uzrokuje značajna prirodne koncentracije u 

okolišu zbog svojeg relativno kratkog vremena poluraspada. Međutim, antropogeni 137Cs 

ispušten nakon nesreće u Černobilu bio je raširen po cijeloj Europi i mogao se detektirati na 

cijeloj sjevernoj hemisferi. Zbog troposferskog transporta i snažnog utjecaja vremenskih uvjeta 

utjecaj nesreće bio je nehomogen nad Europom (UNSCEAR, 2000).  

Uslijed složene meteorološke situacije koja se zadržala nakon nesreće i relativno duge 

izloženosti reaktora atmosferi, radioaktivni materijali taloženi su na velikom području. U blizini 

elektrane taloženi su grafit i čestice iz uništenog reaktora, dok su sitnije čestice pronađene na 

znatnoj udaljenosti od izvorišta. Ovisno o prevladavajućem smjeru vjetra i padalinama u 

tjednima neposredno nakon nesreće, hlapljivi proizvodi kao što su 131Jod (vremenom 

poluraspada od osam dana) i dugoživući 137Cezij (oko 30 godina) bili su rašireni tisućama 

kilometara (Izrael et al., 1996). 131Jod je umjetno proizveden fisijom 235Uranija tijekom 

detoniranja nuklearnog oružja, nadzemnih nuklearnih testiranja i radom nuklearnog reaktora. 

131Jod nalazi se u tokovima plinovitog i tekućeg otpada nuklearnih elektrana, ali se ne ispušta u 

okoliš tijekom normalnog rada reaktora. Izgledno je da su koncentracije navedenih izotopa 

kartirane na slikama 6-7. i 6-8. porijeklom antropogeni.  
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Slika 6-9. Interpolacijska karta koncentracije berilija-7. 
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Slika 6-10. Interpolacijska karta koncentracije kalija-40. 
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7Berilij nastaje u atmosferi reakcijom između kozmičkih zraka (eng. high energy protons) i 

atoma prisutnih u atmosferi u plinovitom stanju, kao što su kisik i dušik. Nakon relativno 

kratkog vremena poluraspada od oko 53 dana, ⁷Be se raspada u ⁷Litij (Bolle et al., 1982).  Nakon 

formiranja, 7Be se povezuje s prisutnim aerosolima te se putem kondenzacije i oborina taloži 

na površinu Zemlje, nakon čega se brzo apsorbira u čestice tla (Taylor et al., 2019). Raspodjela 

koncentracija 7Be prikazana je na slici 6-9.   

40Kalij je primordijalni radionuklid s vrlo dugim vremenom poluraspada od 1.25 milijardi 

godina, zbog čega je prisutan u Zemljinoj kori od nastanka planeta. Kao član skupine alkalijskih 

metala, 40Kalij je široko rasprostranjenu okolišu, osobito u hidrosferi gdje čini preko 90% 

ukupne radioaktivnosti u morskoj vodi. U oko 89,28% slučajeva, 40Kalij se raspada na 40Kalcij 

uz emisiju beta zračenja. U oko 10,72% slučajeva raspada se na 40Argon, čineći osnovu jedne 

od najčešće korištenih metoda za datiranje stijena, minerala, meteorita i drugih geoloških 

materijala (Bolle et al., 1982). 

 

Tablica 6-1. Pearson koeficijenti korelacije elemenata. 
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7. GOSPODARENJE REZIDUIMA 

 

Prema Strategiji zbrinjavanja radioaktivnog otpada, iskorištenih izvora i istrošenog nuklearnog 

goriva (NN 125/14) određene su smjernice za sanaciju lokacija na kojima se nalaze prirodni 

radioaktivni materijali u RH. U dijelu Strategije koji se odnosi na sanaciju lokacija na kojima 

se nalaze prirodni radioaktivni materijali (kao što je bivša tvornica Jugovinil) navodi se da je 

za takve slučajeve potrebno izraditi cjelovit program sanacije koji uključuje tehnološki sigurna 

rješenja koja su prihvatljiva za okoliš. Za izradu programa i osiguranje financijskih sredstava 

potrebnih za sanaciju odgovoran je vlasnik postrojenja.   

Prema točki 6.8. Strategije, područje bivše tvornice Jugovinil mora biti pod regulatornim 

nadzorom. Za sanaciju područja ne treba planirati nikakva dodatna ili nova skladišta ili 

odlagališta na drugim lokacijama, ali ju je obavezno provoditi u skladu sa sigurnosnim 

standardima za zaštitu od zračenja i zaštitu okoliša prema zahtjevima Zakona i Direktive 

2013/59. Namjena lokacija na kojima se nalaze prirodni radioaktivni materijali i programi 

sanacije moraju biti usklađeni s rezultatima odgovarajućih analiza rizika za zdravlje ljudi i 

okoliš (NN 125/14). U 2020. godini Ravnateljstvo civilne zaštite, Ministarstva unutarnjih 

poslova Republike Hrvatske odobrilo je Plan sanacije prema kojemu će se ista provesti u okviru 

izgradnje luke nautičkog turizma, a za kojeg će se provesti postupak Procjene utjecaja na okoliš 

(Eko Invest, 2020).   

Također, prilikom izrade programa sanacije potrebno je razmotriti mogućnost ponovne 

upotrebe onih prirodnih radioaktivnih materijala koji se mogu osloboditi regulatornog nadzora. 

Dobar primjer ponovne upotrebe materijala je korištenje nastalog pepela i šljake za proizvodnju 

građevinskog materijala. Tako se optimizira zbrinjavanje nusproizvoda njihovom ponovnom 

upotrebom. Radioaktivnost navedenih prirodnih radioaktivnih materijala koji se mogu koristiti 

kao sirovina u građevinskoj industriji treba pratiti u skladu s Pravilnikom o praćenju stanja 

radioaktivnosti u okolišu (NN 121/13) (Veinović et al., 2019). 
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8. ZAKLJUČAK 

 

Istraživanje područja bivše tvornice Jugovinil u Kaštelanskom zaljevu pokazalo je da su 

industrijske aktivnosti, osobito rad termoelektrane na ugljen, rezultirale povišenim 

koncentracijama prirodnih radionuklida. Ugljen korišten za rad termoelektrane bio je bogat 

prirodnim radionuklidima poput uranija i torija, čijim raspadom mogu nastati svi prirodni 

radionuklidi njihovih nizova raspada. Otpadni materijali kao što su šljaka i pepeo, akumulirali 

su se u blizini tvornice, a sadržana koncentracija radionuklida dodatno je porasla kroz proces 

sagorijevanja. Tijekom sanacije 1973. ti materijali su premješteni na drugu lokaciju, no 

povišena radioaktivnost ostavila je tragove u određenim zonama istraživanja. 

Osim prirodnih izvora, istraživanje je također otkrilo prisutnost antropogenih izotopa, poput 

137Cezija i 131Joda, koji su povezani sa događajima poput nesreće u Černobilu i nuklearnog 

testiranja. Ovi izotopi proširili su se atmosferskim putem te su detektirani u manjim 

koncentracijama na analiziranom području.  Kartiranje raspodjele koncentracija radionuklida 

omogućilo je bolje razumijevanje mogućih izvorišta zagađenja. Primjenom geostatističke 

metode Empirical Bayesian Kriging (EBK), dobivene su interpolacijske karte deset elemenata 

koji dijele zajedničke žarišne točke u zonama A, Bmt i D. Zona A bila je lokacija stare deponije 

rudne jalovine, na koju se 70-ih godina deponirao i otpad iz zone C. Zona Bmt označava 

područje koje je očišćeno od deponiranog otpada tijekom sanacije 1973. godine, dok je zona D 

lokacija bivše taložnice u kojoj se akumulirali pepeo i šljaka iz termoelektrane. Nad lokacijama 

sa zabilježenim povišenim koncentracijama prirodnih radionuklida potrebno je provoditi 

regulatorni nadzor i cjelovit program sanacije prilikom čega su dobivene karte dobar pokazatelj 

na područja od posebnog interesa. 
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